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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 

statements accompanying such products and services. Nothing herein should be 

construed as constituting an additional warranty. HP shall not be liable for technical or 

editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

For information about third party license agreements, see the Third Party and Open 

Source Notices document in the product installation media directory.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or 

copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, 

Computer Software Documentation, and Technical Data for Commercial Items are 

licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notices

© Copyright 2000-2008 Hewlett-Packard Development Company, L.P.

Trademark Notices

Microsoft®, Windows®, Windows Vista®, and Windows® XP are U.S. registered 

trademarks of Microsoft Corporation.
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Documentation Updates
The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a 

document, go to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP 

Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

Support
Visit the HP Software Support Online web site at:

www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 

support that HP Software offers.

For downloads, see:

https://h10078.www1.hp.com/cda/hpdc/display/main/
index.jsp?zn=bto&cp=54_4012_100__ 

HP Software online support provides customer self-solve capabilities. It provides a fast 

and efficient way to access interactive technical support tools needed to manage your 

business. As a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts
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• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 

Many also require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Preface

Welcome to Service Automation Reporter (SAR), the first configuration management 

database (CMDB) that offers seamless change automation. Leveraging the Server 

Automation (SA), Network Automation (NA), Operations Orchestration (OO), and the 

Application Storage Automation System (ASAS) products, SAR automatically populates 

and maintains all the infrastructure configuration items (CIs), their detailed attributes, and 

interdependencies. After SAR is populated with the data, customers can easily execute 

changes to configure and remediate the IT infrastructure.

Overview of this Guide
This guide describes how to use SAR, starting with an introduction to the system and how 

to navigate the user interface. It provides information about Search, Reports, Dashboard, 

and Custom Reports. 

Contents of this Guide
This guide contains the following chapters and appendices:

Chapter 1: SAR Overview: Provides an overview of SAR, the SAR user interface, the SAR 

Client, and the Search feature.

Chapter 2: SAR Reports: Provides an overview of the SAR Reports feature, and how to 

run, print, export and schedule reports.

Chapter 3: SAR Dashboard: Provides an Overview of the SAR Dashboard and how to 

set the Dashboard options.

Chapter 4: Creating Custom Reports: Provides instructions for saving a search as a 

report, using BIRT RCP Designer to design custom reports, and adding custom reports to 

SAR.
9
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Chapter 1: Introduction to the SAR Client

Overview of SAR 
Service Automation Reporter (SAR) is a configuration management database designed to 

create and maintain a record of the infrastructure data in your IT environment. It has the 

ability to store information from Server Automation (SA), Network Automation, and other 

third party systems. You can use the SAR Search, Reports, and Dashboard features to 

view and analyze IT infrastructure such as applications, servers, networks, and storage.

The SAR features enable you to perform the following tasks:

• Search and browse for configuration items in your IT environment.

I N  T H I S  C H A P T E R

This section discusses the following topics:

• Overview of SAR

• SAR Client and SAR Client Launcher

• SAR Client

• Key Terms and Concepts

• SAR Architecture and Components

• SAR File System Layout

• Search

• Quick Search

• Advanced Search

• Creating and Assigning Security Boundaries for Search

• Item Browser

• Working With NA in SAR

• Working With OO in SAR
11
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• Create reports and view report results on infrastructure data in your IT environment.

• Run existing reports and schedule reports.

• Aggregate report results to your dashboard.

• Create custom reports.

• Perform historical reporting and compare the results with the current report results.

• Perform actions on search and report results.

• Define security boundaries around the configuration items. You can constrain SAR 

feature access based on user permissions. See “Creating and Assigning Security 

Boundaries for Search” on page 42 for more information.

The SAR Client provides the following features:

• Search: Enables you to search and browse for configuration items in your IT 

Environment. See “Search” on page 29 for more information.

• Reports: Enables you create reports, view report results, run existing reports, and 

schedule reports. See “SAR Reports” on page 57 for more information.

• Dashboard: Enables you to aggregate report results to the dashboard. See “Overview 

of Dashboard” on page 49 for more information.

• Opsware Administration: Enables you to set the options for Scheduled Reports and 

Dashboard. See “Setting Dashboard Options” on page 51 for more information.

SAR Client and SAR Client Launcher
The SAR Client Launcher is a self-contained Java application that allows you to access 

the SAR Client from any SAR core. You can use the SAR Launcher to log in to and 

download the latest version SAR Client. If the SAR Client has been upgraded on a specific 

SAR server, you can choose which SAR server you would like to use for downloading the 

SAR Client. 

The SAR Client Launcher also allows you to configure advanced settings, such as debug 

settings, locale settings, and access to the Java Web Start that runs the Launcher and 

SAR Client.

This section contains the following topics: 

• SAR Client and SAR Client Launcher Requirements
2
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• Installing the SAR Client Launcher

• Uninstalling the SAR Client Launcher

• Launching the SAR Client

• SAR Client Launcher Advanced Options

• Launching the SAR Client from the SA Client

SAR Client and SAR Client Launcher Requirements

The SAR Client is a Java application that installs and runs with its own Java Runtime 

Environment (JRE). The SAR Client will not interfere with any other versions of JRE you 

may have installed on your system. The JRE will not be used (and is not usable) by any 

other Java application on the target computer, and it will not set itself as the default JRE 

on the target computer. 

The SAR Client is supported on the following operating systems: 

• Windows 2003

• Windows 2000

• Windows XP

• Windows Vista

The minimum systems requirements to run the SAR Client are as follows: 

• Minimum 1 GB of DRAM

• Minimum 100 MB of disk space

• If using the SAR Client to connect to a core over a residential DSL connection, a 

minimum 384 Kbps DSL connection is recommended. 

• You need to be logged in as a user that has sufficient permissions to install software 

on the computer. (You do not need to be an administrator user to install the launcher.)

To run the SAR Client, you must download and install the SAR Client Launcher 

(accessible from the SAS Web Client). In order to install the SAR Client Launcher, you 

must be a Windows user that is able to install applications on your system.
13
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Installing the SAR Client Launcher

In order to run the SAR Client, you need to download and install the SAR Client Launcher, 

which is a Java application that allows you to access the SAR Client from any SAR server. 

When you install the SAR Client launcher, it installs all the necessary Java applications 

(Java Web Start and JRE) you need to run the SAR Client.

If you plan to have multiple users install the SAR Client Launcher on the same computer, 

SAR recommends that each user choose a unique path to install the application. For 

example, if one user has already installed the SAR Client Launcher in the default location, 

C:\Program Files\Opsware, then if another user logs in to the same computer and 

attempts to install to that same default location, they will see an error and not be able to 

install. If this occurs, choose a new location.

To install the SAR Client Launcher, perform the following steps: 

1 Open a Web browser, and enter the URL to the SAS Web Client of the SA server on 

which you installed the Command Component (OCC) in “Installing SA” in the SAR 

Installation Guide.

2 On the SAS Web Client login page, click the Download Opsware Launcher link.

3 Download the HP BSA Launcher installation file and double-click to start the HP BSA 

Launcher installation. 

4 In the Welcome window, click Next.

5 In the License Agreement window, select the “I accept the agreement” option, and 

then click Next to proceed with the installation.

6 In the Select Destination Directory window, accept the default installation directory, or 

click Browse to select a custom location. Click Next. 

7 In the “Select clients to install” window, select HP Service Automation Reporter 

Client.

8 In the Select Start Menu Folder window, accept the default name and click Next.

9 In the Select Additional Tasks window, accept the default options or choose your 

own, and then click Next to install the SAR Client Launcher. 

10 When the installation has completed, click Finish to exit.
4
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Uninstalling the SAR Client Launcher

You can uninstall the SAR Client Launcher using the Windows Add or Remove Programs 

utility located in the control panel on your system. 

To uninstall the SAR Client Launcher, perform the following steps: 

1 From the Start menu, select ➤  Control Panel. 

2 Double-click the Add or Remove Programs application.

3 In the Currently Installed Programs table, select the HP BSA Launcher application.

4 Click Remove.

5 Close the Add or Remove Programs application.

Launching the SAR Client

The SAR Client Launcher allows you to log in to an SAR server using the SAR Client. You 

also have the option of choosing which SAR server you want to use to download the 

latest version of the SAR Client, separate from the SAR server you log in to. For example, 

when you log into a SAR server and that SAR server has a new version of the SAR Client, 

the new version will automatically be downloaded when you log in. Using the SAR Client 

Launcher, you can choose one core to log in to and a separate core to download the 

latest client. This gives you the freedom to not have to download the SAR Client every 

time you log into a different core.

The SAR Client Launcher only allows you to log on to an SAR 7.0 or 7.50 core. If you 

attempt to log into a pre-7.0 SAR core, you will get a 404 page not found Java Web Start 

error message and not be able to log on to the core. 

(Windows 2000 only) If you are running the SAR Client Launcher on Windows 2000, you 

may see a missing DLL error message when you log on. This error will not affect the log 

on procedure. To fix this so the error message does not appear, install this Microsoft 

update: 

http://support.microsoft.com/default.aspx?scid=kb;en-us;259403&Product=vc6.

To launch the SAR Client, perform the following steps: 
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1 Start the SAR Client Launcher from one of two locations: 

• On your desktop, double-click the HP SAR Client Launcher icon (if you chose to 

install one on your desktop during the installation)

Or

• From the Start menu, select ➤  All Programs ➤ HP Business Service Automation 
➤ HP Service Automation Reporter Client.

2 In the Log In to HP Service Automation Reporter Client window, enter your SAR user 

name, password, and the SAR server you want to log in to, as shown in Figure 1-1. 

Figure 1-1: Log In to SAR Client Window

The user name is not case sensitive. 

Enter the SAR server’s IP address or name in the core server field. If you do not 

specify a port with the host:port notation, port 8443 is used to connect to the SAR 

server. If you are using a port that is not the default value, add a colon followed by 

the port number at the end of the SAR server name in the Core Server name field.

If this is the first time you are logging into a specific SAR server, the launcher will 

download the latest version of the SAR Client when you log in. If you would like to 

differentiate between the SAR server you log in to and the core from which you 

download the latest version of the SAR Client, you can change those options by 
6
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clicking More in the log in window and configuring your Client Host Server. For 

information on this and other advanced SAR Client Launcher options, see “SAR 

Client Launcher Advanced Options” on page 17.

3 Click Log In.

4 If you are asked to accept the certificate from the core server, click Yes. The SAR 

Client now appears. 

SAR Client Launcher Advanced Options

You can configure the following advanced options for the SAR Client:

• Debug Settings: Gives you control over the level of detail as well as the type of 

information included in the SAR Client log file.

• Client Download Server: Allows you to change the host server from which you want to 

download the SAR Client.

• Proxies: Allows you to configure the SAR Client proxy server settings.

• HP Server Automation Home: Allows you to change the default location the SAR 

Client s downloaded and saved on your local computer, to delete the SAR Client’s 

cache, and to change the location of the SAR Client log files.

To configure the SAR Client Launcher’s advanced options, perform the following steps: 

1 Start the SAR Client Launcher from one of two locations: 

• On your desktop, double-click the SAR Client Launcher icon, if you chose to install 

one on your desktop during the installation

Or,

• From the Start menu, select ➤  All Programs ➤ HP Business Service Automation 
➤ HP Service Automation Reporter Client.

2 In the Log In to HP Service Automation Reporter Client window, you can set the 

following SAR Client Launcher options: 

• Username: Enter your SAR username.

• Password: Enter your SAR user password. 

• Core Server: Choose the core server to log into. 

3 Next, click More. In the expanded launcher window, you can configure the following 

settings:
17
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• Locale: Choose a locale to match the localized version of the SAR Client, either 

Japanese (ja), Korean (ko), or English (en). English is the default.

• Debug Settings: Debugging options that are captured in the following log file: 

C:\<install_dir>\Opsware\javaws.log

• Enable Debug Logging (Fine): Enables debugging and sends SAR Client 

operations and errors to the log file. 

• Enable Server Method Call Logging: Adds server method calls to the log file. 

• Show Console: Displays the Java Console window while the SAR Client runs.

4 Click Advanced Settings.

5 In the Advanced Settings window, you can configure the following Launcher options: 

Client Download Server

You can configure the Launcher so the default core you log in to is different from the 

core you use to access the latest version of the SAR Client. This can be useful if you 

do not want to download a new version of the SAR Client each time you log in to a 

different core running the same version of SAR.

• Use Core Server: Select this option to use the default server specified in the 

Core Server field in the main Log In window to be the server from which you 

want to download the SAR Client.

• Use: Enter a core server you want to use to download the SAR Client. 

Proxies

By default, the SAR Client uses the proxy server settings configured for the default 

browser on your local system. For example, if your default browser has no proxy 

server settings configured, neither will the SAR Client. You can change those proxy 

server settings here:

• None: Do not use a proxy server to connect to the SAR Client.

• Use Browser: Use the proxy server settings specified in your default browser. 

• Manual: Enter the proxy server hostname and port. 

• No Proxy Hosts: If you want to add proxy server overrides, add them here, 

separated by commas. (This is only enabled when proxy server settings is set to 

Manual.)

Server Automation Home
8
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• Location: The location where the SAR Client is downloaded and saved on your 

local computer, along with all log files generated when the SAR Client runs.

Note that starting with SAR 7.50, this location also controls where the SAR Client 

data cache is stored.

The default home location is <user_home>\Application Data\Opsware, which is 

private to each user. If you choose to change this location, be aware that other users may 

have access to the new directory. You are responsible for setting the permissions on the 

new directory if you want to prevent unwanted access to your SAR Client home.

• Delete Application Cache: Clicking this completely removes all downloaded 

copies of the SAR Client. This ensures the launcher will download the latest SAR 

Client from the core the next time the user logs in.

• Delete Logs: Delete all log files created by previous sessions of the SAR Client. 

(All SAR Client log files are located at: <user_home>\Application 

Data\Opsware\Deployment\log\*.log.)

6 When you are finished setting the options, click OK to save your settings. 

7 Click Log In to log in to the SAR Client

Launching the SAR Client from the SA Client

To launch the SAR Client from the SA Client, perform the following steps:

1 Launch the SA Client. See the SA User’s Guide: Server Automation for information 

on how to launch the SA Client.
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2 In the SA Client, from the Tools menu, select HP Service Automation Reporter. 
See Figure 1-2. This opens the Log In to SAR Client window as displayed in Figure 1-

1.

Figure 1-2: Launching the SAR Client

3 (Optional) To display Search in the Navigation pane, select Search Pane from the 

View menu in the SAR Client.

SAR Client
The SAR Client user interface provides an easy access to SAR features and functionality. 

The SAR Client user interface has the following main areas: 

• Menus

• Navigation Pane

• Content Pane

• Status Bar
0
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Figure 1-3: SAR Client

Menus

The SAR Client includes the following menus: 

• File: This menu enables you to open a new SAR Client window, close the current 

window, or exit all open SAR Client windows. 

• Edit: This menu enables you to cut, copy, paste, and delete text. 

• View: This menu refreshes the current view and shows the latest information from the 

core that you are currently logged into. You can also access SAR features in the 

Navigation pane, such as Reports (Reports, Dashboard, Scheduled Reports), 

Advanced Search (Search, Quick Search), and Opsware Administration (Schedule 

Report options, Dashboard options). The menu also allows you to show or hide the 

Search pane.

• Actions: Depending on the feature that you have selected in the Navigation pane, 

this menu enables you to perform SAR functions. 

• Window: This menu enables you to access multiple instances of SAR Client 

windows, if more than one window is open. 

Navigation 
pane

Menus

Content 
pane

Status bar
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• Help: This menu provides help for the SAR Client. Help F1 provides context-sensitive 

help relevant to the current feature window selected or opened (same as F1). The 

contents and index will open the SA Client help system to the main table of contents. 

Navigation Pane

To access SAR features, select a feature in the Navigation pane. When you select a 

feature, the details of the feature appears in the Content pane. You can access functions 

related to it through the Actions menu. 

Content Pane

Depending on the selection in the Navigation pane (Advanced Search, Quick Search, 

Reports, Dashboard, Scheduled Report Options, Dashboard Options), the Content pane 

lists the corresponding information.

Status Bar 

At the bottom of the SAR Client Application window, the status bar provides the following 

information: 

• Informational text (left hand side) about the selected object

• A progress bar active when retrieving information from the core

• The user ID

• The time zone set in the user profile
2
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Key Terms and Concepts
The following terms and concepts are used in the SAR feature:

• Configuration Item (CI): An object which can be viewed and managed with SAR. For 

example SAS Server, NAS Device, SAS Patch Policy.

• Attribute: A single property of a configuration item, the value of which describes the 

behavior of the configuration item. Configuration items can have one or more attributes. 

For example, some of the attributes for the configuration item SAS Server includes 

hostname, life cycle, agent status, and management IP.

A custom attribute is displayed only with the Configuration Item it is defined with. For 

example, a custom attribute of a Facility is not displayed when viewing a Server that is 

a member of that facility.
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SAR Architecture and Components
SAR operates with SA to provide analysis and data warehousing capabilities targeted to 

the operational needs of IT organizations. There are three major collections of 

functionality: the SAR Server, the SAR Client, and Data Miners. 

• The SAR Server hosts the underlying physical database, core services, and the loader 

interface. 

• The SAR Client provides a user interface. 

• Data Miners collect information from source systems and forward the collected 

information to the SAR Server to build the data warehouse. 

These components leverage core services provided by a hosting SA installation. 

SAR Server Components

• AAA Login Module: The AAA Login Module redirects login credentials through the twist 

client to the supporting AAA instance that is shared with the hosting SA core.

• BIRT: Business Intelligence Reporting Toolkit (BIRT) is the reporting engine which 

generates formatted report output. BIRT is an open source component derived from the 

Eclipse Project. 

• Catalog: The Catalog application manages the metadata-based data model. The 

catalog is the source of definitions for items, attributes, and relationships. Extensions to 

the SAR data model are managed by the Catalog.

• Conveyor: The Conveyor application provides configuration information to a Data Miner 

present on a remote data source. The Data Miner receives updates to the ETL 

definitions from the Conveyor. These ETL definitions control what information is 

collected from each source and how that information is mapped to items, attributes and 

relationships in the SAR database.

• Cooper: Cooper is the core web services interface to the SAR. All SAR Client data 

interaction is controlled by Cooper. 

• JAAS Security: The Java Authentication and Authorization Service (JAAS) Security 

module marshals authentication, functionality authorization, and security filtering of 

query information. 

• Loader: The Loader inserts data records created by Data Miners into the data 

warehouse. Because the order of delivery of data from the Data Miners is not 

guaranteed, the Loader is responsible for reconstructing the sequence of events as the 
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records are inserted. The Loader also verifies the incoming data records to confirm the 

data is not corrupted. 

• SAR JDBC Driver: The SAR JDBC Driver implements security filtering by refactoring 

database queries to limit access to information according to a user’s security rights. The 

SAR JDBC driver acts in conjunction with a standard JDBC Driver to access the 

underlying physical representation through the database.

• SAR rsync Server: The SAR Data Miner delivers data records to the Loader using the 

rsync protocol. The rsync Server listens for these connections from the Data Miner and 

deposits data records for the Loader to process.

• Oracle Database Instance: The SAR data warehouse uses an Oracle database to store 

information. 

• Scheduler: The Scheduler component maintains the queue of scheduled reports and 

executes those scheduled reports according to their specified schedule. 

• Twist Client: The Twist Client dispatches Universal API (UAPI) calls to the Twist 

application service of the SA Mesh.

SAR Client

The SAR Client is the user interface to the SAR. The SAR Client provides specific 

capabilities for report presentation, search, ad-hoc searching and report building, and 

administrative capabilities. 

SAR Data Miner

SAR Data Miners collect information for all data sources using the rules specified by the 

ETL definitions. This source data is formatted into an XML format along with checksum 

and signature information. 

SA Common Services

• AAA: The Authentication, Authorization, and Auditing component provides core AAA 

services to SA and SAR, including user and group accounts, authorization for specific 

SAR features, and representation of SAR data access boundaries. 

• Twist: The Web Service Data Access Engine (Twist) provides programmatic access to 

services. SAR uses the Twist API to access the AAA component. 
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SAR File System Layout
This section describes the file system layout of the SAR Database and the SAR Core 

Services. The default SAR database file system layout is presented in Table 1-1.

Table 1-1: SAR Database File System Layout 

/u01/ Location of Oracle application, instance 

admin files, and a control file

/u01/app/oracle/product/

10.2.0/db_1/network/admin/

tnsnames.ora

config for SAR instance

/u01/app/oracle/product/

10.2.0/db_1/network/admin/

omdb.listener.ora

config for SAR instance

/u01/app/oracle/product/

10.2.0/db_1/dbs/orapwcmdb

SAR password file

/u01/app/oracle/product/

10.2.0/db_1/dbs/spfilecmdb.ora

SAR config file

/u01/app/oracle/admin/cmdb/

bdump,cdump,pfile,udump

Oracle SAR instance log and support files

 /u01/app/oracle/admin/cmdb/

create/

Scripts to create database

 /u01/app/oracle/admin/cmdb/

create/metaschema

Schema creation scripts

 /u01/app/oracle/admin/cmdb/

dataschema

Data creation scripts

 /u01/oradata/cmdb/ SAR control file #1

 /u02/ Location of data files

 /u02/oradata/cmdb/ SAR data files

 /u03/oradata/cmdb/ CMDB control file #2, and redo logs group 

#1
6
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 /u04/ Location of second member of redo log 

groups, and a control file

 /u04/oradata/cmdb/ CMDB control file #1, and redo logs group 

#2

 /etc/oratab Entry for SAR instance

Table 1-1: SAR Database File System Layout  (continued)
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The default SAR Core Services file system layout is presented in Table 1-2.

Table 1-2: SAR Core Services File System Layout 

/opt/opsware/omdb Root of the primary install location

/opt/opsware/omdb/bin Location of SAR Core Services binary 

executables

/var/opt/opsware/crypto/omdb/ cryptographic certificates for omdb, twist

/opt/opsware/omdb/dist Location where the Data Miner installer and 

cert are deployed

/opt/opsware/omdb/conf JBoss configuration directory

/opt/opsware/omdb/dbinstaller Used by SAR to configure the database

/opt/opsware/omdb/deploy SAR JBoss deploy files that are not in OCC, 

such as loadersar, cooper.jar, and so on

/opt/opsware/omdb/deploy/

birt.war/

Directory for the BIRT Engine. Also the 

default location for pas_actions.xml.

/opt/opsware/omdb/omdb/ Hierarchy is the same as the SA OCC

/opt/opsware/omdb/omdb/deploy/ JBoss deployment, hierarchy the same as 

SA OCC

/opt/opsware/omdb/omdb/deploy/

jbossweb-tomcat55.sar/

Apache webserver deployment directory

/opt/opsware/omdb/reports/ SAR report definitions

/var/opt/opsware/install_

opsware/config_file_archive/

if SAR has been upgraded, the following 

files from the earlier version are archived 

here:

• omdb.properties

• omdb-reporter-ds.xml

• cmdb-ds.xml

• cmdb-admin-ds.xml
8
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Search
In the SAR Client, the Search feature allows you to search for any information about your 

operational environment that is available in Server Automation, Network Automation, 

Operations Orchestration, and any third party systems. 

You can also search for storage Database, SAN Switch, Server, and Storage Systems 

objects if you have purchased Application Storage Automation System (ASAS). For more 

information, see the ASAS User’s Guide.

Application Storage Automation System is a separately licensed product that requires 

Server Automation (SA). To visualize any storage data in ASAS, you must license a version 

of Service Automation Visualizer (SAV) for ASAS. If you have not purchased SAV and 

would like to, contact your sales representative.

The SAR Search feature enables you to perform the following actions:

• Perform a search by using keywords.

• Perform an advanced search by creating search queries.

• Browse for configuration items in your IT environment.

• Search for historical data by selecting the date and time for the search query.

/var/opt/opsware/omdb/collect/ Location of SAR Core Services Loader Col-

lect directory - Data Miner collected data is 

stored here

/etc/opt/opsware/omdb/ Location of SAR Core Services configura-

tion files

/etc/inet.d/opsware-omdb SAR Core Services daemon launch script

/var/log/opsware/omdb/ Log files for SAR

(If a Data Miner is installed on a server, the 

JVM output for the Data Miner is stored in 

dm_jvm.log in this directory.)

Table 1-2: SAR Core Services File System Layout  (continued)
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• Save a search query. 

• Perform actions on search results. You must have Server Automation 6.5 or later 

installed to perform actions on SA results, Network Automation 7.0 or later installed to 

perform actions on NA results, and Operations Orchestration 7.0 installed to perform 

actions on OO results. 

• Export search results. 

• Customize search results formatting using the Results Options window. 

• View Item Browser for search results.

Performing a Search 

In the SAR Client, you can search for configuration items by entering a keyword in the 

search text field. The search is carried out against the default displayable attributes 

defined for the configuration item in the SAR data catalog.

The search operation returns only configuration items where you have the data access 

permissions. See the SAR Installation Guide for information on SAR permissions.

To carry out a search, perform the following steps:

1 From the Navigation pane, select Search. To display Search in the Navigation pane, 

select Search Pane from the View menu.

2 From the drop-down list, select the type of item that is the target of the search. 

Figure 1-4 shows a search for the NAS User named Bob. 

Figure 1-4: Simple Search in the SAR Client

3 Enter the search text in the text field. The SAR Client search feature does not support 

a wildcard search and the search is not case sensitive.

4 Click  to search. The search results appear in the Content pane. 
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5 (Optional) Click on any column heading to sort the search results. You can also 

change the order of the columns by dragging the column heading and dropping it 

into the desired location.

6 (Optional) Click Results Options to specify the attribute to be displayed as column 

headings for the search results. 

Perform the following steps to customize the column headings:

1. In the Results Options window, from the All Available Attributes list, select the 

attributes you want to display as column headings for the search results. Click 

Add. The attributes now appear on the right pane. See Figure 1-5.

Figure 1-5: Results Option Window

2. To reorder the attributes, select the attribute in the right pane and then click Up or 

Down. 

3. To remove the attribute, select the attribute in the right pane and then click 

Remove.

4. To change the display name of the attribute in the column heading, select the 

attribute in the right pane and then enter a new name in the Column Display 

Name field.
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5. To select the sort order of the attribute on the search results, select the attribute in 

the right pane and then select the order number from the Sorting Order drop-

down list.

6. To sort the search results for an attribute, select the attribute in the right pane and 

then select Ascending or Descending from the Sorting Order drop-down list.

7. To make the sorting order case sensitive, select the attribute in the right pane and 

then select the Case Sensitive check box.

8. Click OK to display the selected attributes as column headings. Click Apply to 

save.

9. To add additional attributes, select the relationship from the Configuration Item 

drop-down list as shown in Figure 1-6. The additional attributes appear in the All 

Available Attribute list. Perform the instructions listed in steps 1 to 7 to add or 

remove additional attributes.

Figure 1-6: Adding Additional Attributes to the Results Option Window

7 (Optional) Click Save to save your search query. The Save Search window appears. 

Enter the name of the search and click Save. The name of the saved search cannot 

be more than 64 characters. The search is saved in a folder corresponding to the 

configuration item types in the Advanced Search location in the navigation pane.
2
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8 (Optional) In the Save Search window, select Save as a Report Definition to create 

custom reports. See “Editing a Report Definition File” on page 80 for more 

information.

9 (Optional) Click Export at the bottom of the screen to export search results. The 

Export Results window appears. Enter the location, the file name and the file type 

and then click Export Results. You can export SAR search results as .csv or .html 

files.

10 (Optional) After you export the search results, you can email the search results by 

attaching the exported file to the email. You can also print the search results by 

printing the exported file from an application that supports .csv or .html files.

11 (Optional) To perform an action on the search results, select an item from the 

Content pane and then from the Actions menu, select the appropriate action. 

Quick Search
Quick Search allows you to browse all the configuration items available in SAR by 

selecting the configuration item and then the attribute and value for that item. 

Performing a Quick Search

The search operation returns only configuration items on which you have the data access 

permissions. See the SAR Installation Guide for information on SAR permissions.

To carry out a quick search, perform the following steps:
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1 From the Navigation pane, select Advanced Search ➤  Quick Search. Quick 

Search is displayed in the Content pane as shown in Figure 1-7.

Figure 1-7: Quick Search in the SAR Client

2 From the Item Type list in the Content pane, select the configuration item type you 

would like to browse. The list of attribute categories for the selected configuration 

item appear in the Attribute Category list.

3 From the Attribute Category list, select an attribute category.

4 Select the attribute from the Attribute list and then select the value for that attribute 

from the Value list. The search results appear in the content pane.

5 (Optional) Click on any column heading to sort the search results. You can also 

change the order of the columns by dragging the column heading and dropping it 

into the desired location.

6 (Optional) Click Save to save your search query. The Save Search window appears. 

Enter the name of the search and click Save. The name of the saved search cannot 

be more than 64 characters. The search is saved in a folder corresponding to the 

configuration item type in the Advanced Search location in the navigation pane.

7 (Optional) In the Save Search window, select Save as Report Definition to create 

custom reports from your search results. See creating custom reports for more 

information.
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8 (Optional) Click Export at the bottom of the screen to export search results. The 

Export Results window appears. Enter the location, the file name and the file type 

and then click Export Results. You can export SAR search results as csv or .html 

files.

9 (Optional) After you export the search results, you can email the search results by 

attaching the exported file to the email. You can also print the search results by 

printing the exported file from an application that supports .csv or .html files.

10 (Optional) To perform an action on the search results, select an item from the 

Content pane and then from the Actions menu, select the appropriate action.

Advanced Search
In the SAR Client, an Advanced Search enables you to create queries on search items. In 

the search query, you can specify rules and combine each rule with a logical “And” or “Or” 

operator. You can use both the “And” and “Or” operator in a single search query. Each rule 

is a combination of an attribute/operator/value that enables you to search for a specific 

attribute value for the selected search item. For the search item, depending on the 

attribute that you select, the options for the operator and value are displayed. 

You can specify the attribute values by entering text or a numerical value in the text field, 

or by selecting a value from the drop-down list, or by selecting multiple values from a list 

of values in the Select Values window. See Figure 1-8.

Figure 1-8: Advanced Search 
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The Select Values window appears when you need to specify multiple values for a rule 

containing a “is one of” or “is not one of” operator. In this window, you can select multiple 

values from the list or add values to the Additional field. See Figure 1-9.

In SAR, when you perform a search of any configuration item and you select " Equals” or 

“Does not equal" or “Is one of” or “Is not one of” in the operator field, then the values 

listed in the Value field depends on the values existing in the SAR database as of the 

selected date. If the other values in the SAR database are not relevant for the selected 

date then those values will not be listed in the Value field.

Figure 1-9: Select Values Window
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You can create complex queries by selecting multiple relationships or in-line blocks for a 

configuration item and also multiple rules for each relationship. See Figure 1-10.

Figure 1-10: Complex Query Containing Multiple Relationships

In a complex query, you can also set the precedence on the Or/And logic for the different 

rules in that query. In any query, by default the Or logic takes precedence over the And 

logic. In Advanced search, you can use the In-Line Search Block to prioritize the And/Or 

logic for rules in a query. See Figure 1-11.
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Figure 1-11: Complex Query Containing In-Line Block

Using Advanced Search you can search for historical data by selecting the date and time 

for the search query. You can then compare the historical data with the current results or 

create custom reports for both the current search results and the historical search results. 

See “Editing a Report Definition File” on page 80 for information on how to create custom 

reports.       

Performing an Advanced Search

The search operation returns only configuration items on which you have the data access 

permissions. See the SAR Installation Guide for information on SAR permissions.

To carry out an advanced search, perform the following steps:

1 From the Navigation pane, select Advanced Search ➤  Advanced Search. The 

Advanced Search page appears in the Content pane. 
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2 From the Search for Configuration Item drop-down list, select the item you want to 

search. From the As of Date drop-down list select the date and from the Time drop-

down list select the time to carry out the search.

Figure 1-12: Advanced Search in the SAR Client

3 Create a rule by selecting the attribute from the first drop-down list. Depending on 

the attribute that you select, options available for the operator and values for the rule 

could change.

4 Select the operator from the second drop-down list. The operator selected defines 

how the search text is treated. 

5 Enter a value in the field or select a value from the drop-down list or click  to 

select multiple values from the Select Values window. 

6 Click  to add additional rules and repeat steps 3 to 5. Click  to delete any 

rules.

7 Select the logic (And/Or) to be applied for every rule in the query. 

8 (Optional) To add a relationship to the search query, select the relationship (indicated 

in italics) from the left-most drop-down list. Create rules by following instructions 

listed in steps 3 to 7.

9 (Optional) To set precedence for any rule in a query, select In-Line Search Block from 

the first drop-down list. Then create rules for the query by following instructions listed 

in steps 3 to 7.

10 Click Search to run the search query. The search results appear in the Content pane. 
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11 (Optional) Click on any column heading to sort the search results. You can also 

change the order of the columns by dragging the column heading and dropping it 

into the desired location.

12 (Optional) Click Results Options to specify the attribute to be displayed as column 

headings for the search results. Perform the following steps to customize the column 

headings:

1. In the Results Options window, from the All Available Attributes list, select the 

attributes you want to display as column headings for the search results. Click 

Add. The attributes now appear on the right pane.

2. To reorder an attribute, select the attribute in the right pane and then click Up or 

Down. 

3. To remove an attribute, select the attribute in the right pane and then click 

Remove.

4. To change the display name of the attribute in the column heading, select the 

attribute in the right pane and then enter a new name in the Column Display 

Name field.

5. To select the display order of the attribute on the search results, select the 

attribute in the right pane and then select the order number from the Sorting 

Order drop-down list.

6. To order the search results for an attribute, select the attribute in the right pane 

and then select Ascending or Descending from the Sorting Order drop-down list.

7. To make the sorting order case-sensitive, select the attribute in the right pane and 

then select the Case Sensitive check box.

8. Click Apply to display the selected attributes as column headings. Click OK to 

close the window.

9. To add additional attributes, select the relationship from the Configuration Item 

drop-down list as shown in Figure 1-6. The additional attributes appear in the All 

Available Attribute list. Perform instructions listed in steps 1 to 7 to add or remove 

attributes.

13 (Optional) Click Save to save your search query. The Save Search window appears. 

Enter the name of the search and click Save. The name of the saved search cannot 

be more than 64 characters. The search is saved in a folder corresponding to the 

configuration type in the Advanced Search location in the Navigation pane.
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14 (Optional) In the Save Search window, select Save as Report Definition to create 

custom reports. See creating custom reports for more information.

15 (Optional) Click Export at the bottom of the screen to export search results. The 

Export Results window appears. Enter the location, the file name and the file type 

and then click Export Results. You can export SAR search results as .csv or .html 

files.

16 (Optional) After you export the search results, you can email the search results by 

attaching the exported file to the email. You can also print the search results by 

printing the exported file from an application that supports .csv or .html files.

17 (Optional) To perform an action on the search results, select an item from the 

Content pane and then from the Actions menu, select the appropriate action. 

Exporting Search Results

To export search results, perform the following steps:

1 Perform a search in the SAR Client. The search results appear in the Content pane.

2 Click Export at the bottom of the screen to export search results. The Export Results 

window appears. 

3 Enter the location, the file name and the file type and then click Export Results. You 

can export SAR search results as .csv or .html files.

Running a Saved Search Query

To run a saved search query, perform the following steps:

1 From the Navigation pane, select Advanced Search ➤  Advanced Search. 

2 Navigate the folder hierarchy to select the search query. The search results will 

appear in the Content pane.

Deleting a Saved Search

To delete a saved search query, perform the following steps:

1 From the Navigation pane, select Advanced Search ➤  Advanced Search. 

2 Navigate the folder hierarchy to select the search query. The search results will 

appear in the Content pane.

3 Click Save Search. The “Save or Delete your search” window appears. 
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4 In the Saved Searches field, select the saved search and click Delete. 

5 Click Delete on the “Delete existing search” confirmation window.

Creating and Assigning Security Boundaries for Search
The Security Boundaries feature allows you to choose custom search parameters that you 

can then save and assign to a user or a group of users in SAR. You can define a Security 

Boundary as one or more attributes of one or more configuration items. You create a 

security boundary in the SAR Client. You assign security boundaries in the SAS Web 

Client. 

If you select the Security Boundary option, click Select to display the Select Security 

Boundaries window. 

Creating Security Boundaries

To create a security boundary, perform the following steps:

1 Launch the SA Client. The SA Client appears. 

2 From the Tools menu, select HP Service Automation Reporter. The SAR Client 

window appears. 

3 From the View menu, select Opsware Administration ➤  Security Boundaries.

4 Select a Configuration Item from the drop-down list. 

5 In the drop-down list for (the Asset Tag, Hostname, and so on), select Contains, 

Equals, or the appropriate association.

6 In the text field, type the appropriate value. 

7 (Optional) Click + and then repeat the preceding three steps to define a second 

criteria. 

8 Click Preview Security Boundary to view the current items defined within the 

security boundary. 

9 Click Save to save the security boundary.

Assigning Security Boundaries

To assign a security boundary to a group, perform the following steps:
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1 Log in to the SAS Web Client as an administrator. The SAS Web Client Home Page 

appears. 

2 In the Navigation pane, select Administration ➤  Users & Groups. The View Users 

pane is displayed.

3 Click the Groups tab. The Groups tab is displayed.

4 Select the group you want to set a security boundary for. The group is displayed in 

the View Groups pane.

5 Click the OMDB Features tab. The OMDB Features tab is displayed.

6 Clear All Data Access Permissions.

7 For the CI Type you want the group to use a security boundary for access to that 

data, select the Security Boundary option. 

8 Click Select. The Select Security Boundaries window is displayed.

9 Click a security boundary in the Unassigned Boundaries list, and then click -> to 

move the selected security boundary to the Assigned Boundaries list.

10 Click Save. The Select Security Boundaries window closes. 

11 In the OMDB Features of the View Groups pane, click Save.

You can select multiple security boundaries in the Select Security Boundaries window to 

control data access for a single CI Type. Users that are members of groups with different 

security boundaries for data access have access to all the data viewable by the individual 

groups. For example, suppose a user is a member of two groups: 

• SAS Users - Security boundary defined for all SA data

• NAS Users - Security boundary defined for all NA data

The user can see all the CI Types for both SA data and NA data. 

Item Browser
The Item Browser in the SAR Client allows you to view all the available attributes for the 

selected configuration item. The Item Browser enables you to view additional information 

about the configuration item and its relationships.
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The Item Browser consists of two main components: the Views pane and the Content 

pane. The Views pane lists all the available attribute categories for the selected 

configuration item, and the Content pane displays the details of the selected attribute. 

When you select an attribute in the Views pane, its corresponding details appear in the 

Content pane. See Figure 1-13.

Figure 1-13: Item Browser
4
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The list of attribute categories in the Item Browser varies depending on the configuration 

item returned in the search or report results. For example, Figure 1-13 shows an Item 

Browser for the configuration item SAS server, and Figure 1-14 shows an Item Browser for 

the configuration item “NAS Device”.

Figure 1-14: Item Browser for NAS Device

Accessing the Item Browser

Perform the following steps to access the Item Browser:

1 In the SAR Client, perform a search or run a report. 

2 Select an item from the search or report results and then from the Actions menu, 

select View. The Item Browser for the selected configuration item appears.
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Working With NA in SAR
SAR provides support for working with NA from within SAR. 

The SAR Client must be able to communicate with the NA server to support NA 

actionability from within the SAR Client. See “Open Ports” in the SAR Installation Guide.

Enabling NA Actionability

To make a NA device actionable in SAR, the SA and NA servers must be configured 

properly for integration. For more information see “Setup for NA Integration” in SA User’s 

Guide: Server Automation.

Opening a NA Device from SAR

To launch NA from within SAR, perform the following steps:

1 From the Navigation pane, select Search. To display Search in the Navigation pane, 

select Search Pane from the View menu.

2 From the drop-down list, select the CI Type “NAS Device”. 

3 (Optional) Enter text to narrow the search results into the text field. The SAR Client 

search feature does not support a wildcard search and the search is not case 

sensitive.

4 Click  to search. The search results appear in the Content pane. 

5 In the Content pane, right-click on the object that you want to work with, and select 

Open. The NA login page is displayed in a browser window.

If an error message appears, contact either or both of your SAR and NA administrators.

Working With OO in SAR
SAR provides support for working with Operations Orchestration (OO) from within SAR. 
6
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The SAR Client must be able to communicate with the OO server to support OO 

actionability from within the SAR Client. See “Open Ports” in the SAR Installation Guide.

Setting OO Options

To set parameters for OO workflows, perform the following steps:

1 Launch the SAR Client. The SAR Client appears. 

2 From the View menu, select Opsware Administration ➤  Operations 
Orchestrations Options.

3 In the Hostname field, type the OO server hostname. The field does not allow 

spaces. You can enter any DNS-resolvable hostname format, including localhost, 

127.0.0.1, pas.server.example.com, or pas_server. 

4 (Optional) In the Port [8443] field, type the port number. The default value is 8443 if 

you do not type a different port number.

5 In the Username and Password fields, type the username and password for the 

account on the OO server the workflow should run as.

6 Click Save Values.

Running OO Actions From SAR

The task “Setting OO Options” must be completed before you can perform this task. To 

search for and launch an OO Flow from SAR, perform the following steps:

1 From the Navigation pane, select Search. To display Search in the Navigation pane, 

select Search Pane from the View menu.

2 From the drop-down list, select the CI Type of the SAR object you want to run an OO 

Flow on. For example, select the CI Type “SAS Server”. 

3 (Optional) Enter text to narrow the search results into the text field. The SAR Client 

search feature does not support a wildcard search and the search is not case 

sensitive.

4 Click  to search. The search results appear in the Content pane. 

5 In the Content pane, right-click on the object that you want to work with, and select 

Run Flow. The Run Flow window is displayed.

6 Select the Flow Name of the OO Flow you want to run.
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7 Click OK. After a few seconds, a response window will be displayed that presents the 

status of the OO action. 

If an error message appears, contact either or both of your SAR and OO administrators.
8
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Overview of Dashboard
The SAR Dashboard displays summary type SAR reports allowing you to view important 

reports on a daily basis. It contains one or more of the following summary reports in a 

graphical format: 

• Devices by Type

• Servers by Operating System

• Network Devices by Device Type

• Servers by Architecture

You can drill down into the summary report to view the complete report in detail. In the 

Dashboard, you can perform the following actions on the summary reports:

• Print reports

• Export SAR report results as .html, .pdf, or .xls files

• Drill down the summary report to view the complete report in detail

• Perform actions on report results 

I N  T H I S  C H A P T E R

This section discusses the following topics:

• Overview of Dashboard

• Viewing the SAR Dashboard

• Setting Dashboard Options
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By default, the Dashboard contains the following four reports as shown in Figure 2-1:

• Devices by Type Over the Last 30 Days: This report displays the devices (servers and 

network devices) deployed over the last 30 days at daily intervals.

• Servers by Operating System Over the Last 30 Days: This report displays the 

servers organized by operating system and version over the last 30 days at daily 

intervals.

• Network Devices by Type Over the Last 30 Days: This report displays the network 

devices (such as routers, switches) deployed over the last 30 days at daily intervals.

• Servers by Architecture Over the Last 30 Days: This report displays the servers 

organized by CPU architecture over the last 30 days at daily intervals.

Figure 2-1: SAR Dashboard
0
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In the SAR Client, you can also create and configure your own personal Dashboard. You 

can select up to eight reports to be displayed in your Dashboard from the list of reports 

mentioned above. You can also configure your Dashboard to be in either a one-column 

or two-column layout. See “Setting Dashboard Options” on page 51 for more information.

When you launch the SAR Client, by default the Search feature is displayed in the 

Content pane. You can also configure the dashboard options to display the Dashboard 

feature in the Content pane when you first launch the SAR Client. See “Setting 

Dashboard Options” on page 51 for more information.

Viewing the SAR Dashboard
To view the Dashboard in SAR, perform the following steps:

1 In the SAR Client, from the Navigation pane, select Reports ➤  Dashboard. The 

default Dashboard appears in the Content pane. 

2 To create your personal Dashboard, see “Setting Dashboard Options” on page 51.

3 (Optional) To view the complete report in detail, click on any report in the Dashboard. 

The complete report appears in the Content pane.

4 (Optional) Click Export to export the reports displayed in the Dashboard. The Export 

Results window appears. Enter the location, the file name and the file type and then 

click Save. You can export SAR report results as .html, .pdf, or .xls files.

5 (Optional) Click Print to print the reports displayed in the Dashboard. 

6 (Optional) To perform an action on the report results, select an item from the Content 

pane and then right-click to select the appropriate action. 

Setting Dashboard Options
In the SAR Client, you can create and configure your own personal Dashboard. You can 

select up to eight reports to be displayed in your Dashboard and specify the parameter 

values for those reports. You can also configure your Dashboard to be in either a one-

column or two-column layout.
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To configure the Dashboard options, perform the following steps:

1 In the SAR Client, from the Navigation pane, select Opsware Administration ➤  

Dashboard Options. The Dashboard Options appears in the Content pane. 

Figure 2-2: Dashboard Options

2 From the Startup Location options, select an option to be displayed every time you 

launch the SAR Client. You can select either Reports, Search, or Dashboard. Select 

the Dashboard option to display the Dashboard feature when you launch the SAR 

Client.
2



Chapter 2: SAR Dashboard
3 From the Dashboard Selector options, select Custom Dashboard to configure your 

Dashboard using the reports that are available.

4 From the Custom Dashboard Column Selector options, select One Column to display 

the reports in a one-column format in the Dashboard. Select Two Columns to display 

the reports in a two-column format in the Dashboard.

The One Column and Two Columns display options in the Custom Dashboard Column 

Selector options have separate settings for configured reports and parameters. For 

example, any customizations made in the One Column display do not transfer to the Two 

Columns display, but are preserved if you switch back to the One Column display.

5 Click Save Layout to save the Dashboard options.

Configuring a Report In The Dashboard

To configure a report in the Dashboard, perform the following steps

Different reports have different report parameters to configure. For example, for the report 

"Network Devices by Device Type," you can configure the parameters such as Device 

Group, Vendor, and Model. For the report “Servers by Operation System”, you can 

configure the parameters such as Customer, Facility, and Device Group.

1 In the SAR Client, from the Navigation pane, select Opsware Administration ➤  

Dashboard Options. The Dashboard options appears in the Content pane.

2 From the Custom Dashboard Configuration Panel in Report 1, select a report from the 

Report File drop-down list.

3 (Optional) Enter the report title in the Title field, or the default report name will be 

used for the report title.
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4 Click Configure. The Report Dialog window appears.

Figure 2-3: Report Dialog Window

5 From the Date Range drop-down list, select a date range to run the report. From the 

Interval drop-down list, select the time interval to run the report. The Interval drop-

down list allows you to group the data on a daily, weekly, or monthly time interval

6 From the Customer drop-down list, specify the customer to be included or excluded 

in the report.

7 From the Facility drop-down list, specify the facility to be included or excluded in the 

report.
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8 From the Device Group drop-down list, specify the device group to be included or 

excluded in the report.

9 Click Run. The report with the specified parameters is displayed in the Content pane.

10 Click OK to save your changes or click Cancel to close the window.

11 To configure more reports, repeat the above steps.

12 Click Save Layout to save the Dashboard options.
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Overview of SAR Reports
The SAR Client Reports feature provides comprehensive information about managed 

servers, network devices, software, patches, customers, facilities, operating systems, 

compliance policies, and users and security in your environment. These parameterized 

reports are presented in graphical and tabular format, and are actionable—which means 

that you can perform appropriate actions on objects, such as a policy or an audit, within 

the report. These reports are also exportable to your local file system (as .html, .pdf and 

.xls files) to facilitate use within your organization.

I N  T H I S  C H A P T E R

This section discusses the following topics: 

• Overview of SAR Reports

• Reports Features

• SAR Client Reports

• User Permissions

• Launching the Reports Feature

• Reports Display

• Running a Report

• Report Results

• Exporting a Report

• Printing a Report

• Saving a Search as a Report

• Scheduling a Report
57



User’s Guide

5

You can also search for storage Database, SAN Switch, Server, and Storage Systems 

objects if you have purchased Application Storage Automation System (ASAS). For more 

information, see the ASAS User’s Guide.

Application Storage Automation System is a separately licensed product that requires the 

Server Automation (SA). To visualize any storage data in ASAS, you must license a version 

of Service Automation Visualizer (SAV) for ASAS. If you have not purchased SAV and 

would like to, contact your sales representative.

This section contains information about the types of SAR Client reports, how to modify 

report parameters, how to run the reports, and how to perform actions in the report 

results.

Reports Features
SAR Client Reports enable you to perform enterprise health assessments by providing the 

following features:

• Actionable reports that enable you to take the appropriate action on objects within the 

reports. For example, in the list view of a compliance report, you can select a server 

and open a Remote Terminal or Server Explorer to browse it, perform an audit, create a 

snapshot, create a package, and so on.

• The SAR Client Dashboard provides a display of selected reports. See “Viewing the 

SAR Dashboard” on page 51.

• Reports that are data-secured—controlled by the user’s permissions to the data.

• Reports that can be run on either current or historical data.

• Reports that are printable and also exportable to .html, .pdf, and .xls formats. You can 

export reports to your local file system for use within your organization.

• Custom reports can be created and imported. See “Editing a Report Definition File” on 

page 80.

• Reports that can be scheduled to run automatically and to email the results to you and 

others.
8
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SAR Client Reports
Table 3-1 lists the SAR Client Reports by report folders.

Table 3-1: SAR Client Reports

REPORT FOLDER REPORT TITLE

Compliance History Device Compliance History - Provides a detailed compliance 

state history for all servers, or for one or more selected servers

Device Group Compliance History - Summarizes the compli-

ance history of devices in a specified device group

Customer Compliance History - Summarizes the compliance 

history of devices assigned to a specified customer

Facility Compliance History - Summarizes the compliance his-

tory of devices in a specified facility

Deployment Life Cycle Devices By Type - Filters network devices by group, and non-

network devices by customer, facility, or group

Network Devices By Device Type - Provides a deployment 

trend history for the network devices in a specified group, 

organized by device type

Servers By Operating System - Provides a deployment trend 

history for the servers in a specified customer, facility or group, 

organized by operating system and version

Servers By Architecture - Groups the servers in a specified 

customer, facility or group organized by architecture
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Storage Reports - Host 

and Application Stor-

age Reports

Host Capacity and Utilization Overview - Provides detailed 

capacity & utilization information for multiple hosts, potentially 

grouped by customer, facility or device group.

Host Capacity and Utilization Trend Data - Provides detailed 

capacity & utilization trend data for a collection of hosts, 

grouped by customer, facility or device group.

Host Total Storage Utilization Trend - Provides total storage 

utilization rate for a set of hosts (grouped by customer, facility 

or device group), has changed over time and is projected to 

change in the future.

Host Total Storage Allocation Trend - Provides total allocated 

and used storage for a set of hosts (grouped by customer, 

facility or device group), has changed over time and is 

projected to change in the future.

Host Volume Manager Storage Utilization Trend - Provides 

volume manager storage utilization rate for a set of hosts 

(grouped by customer, facility or device group), has changed 

over time and is projected to change in the future.

Host Volume Manager Storage Allocation Trend - Provides 

allocated and used volume manager storage for a set of hosts 

(grouped by customer, facility or device group), has changed 

over time and is projected to change in the future.

Host DB Storage Utilization Trend - Provides database storage 

utilization rate for a set of hosts (grouped by customer, facility 

or device group), has changed over time and is projected to 

change in the future.

Host DB Storage Allocation Trend- Provides allocated and 

used database storage for a set of hosts (grouped by 

customer, facility or device group), has changed over time and 

is projected to change in the future.

REPORT FOLDER REPORT TITLE
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Storage Reports - Host 

and Application Stor-

age Reports 

(continued)

Host Filesystem Storage Utilization Trend - Provides filesystem 

storage utilization rate for a set of hosts (grouped by customer, 

facility or device group), has changed over time and is 

projected to change in the future.

Host Filesystem Storage Allocation Trend - Provides allocated 

and used filesystem storage for a set of hosts (grouped by 

customer, facility or device group), has changed over time and 

is projected to change in the future.

Host Reclaimable Storage Overview - Provides capacity 

information grouped by hosts.

Host Storage Detail- Provides detailed storage information for 

a selected host.

REPORT FOLDER REPORT TITLE
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Storage Reports - Data-

base Storage Reports

Tablespace Capacity and Utilization Overview - Lists 

tablespaces and their capacity and utilization information, 

grouped by database.

Database Utilization Trend - Provides how utilization 

information for a set of databases has changed over time and 

is projected to change in the future.

Database Allocation Trend - Provides how allocated and used 

capacity for a set of databases has changed over time and is 

projected to change in the future. 

Database Capacity and Utilization Trend Data - Provides 

detailed capacity and utilization trend data for a set of 

databases. 

Tablespace Utilization Trend - Provides how utilization for a set 

of tablespaces within a specific database has changed over 

time and is projected to change in the future. 

Tablespace Allocation Trend - Provides how allocated and 

used capacity for a set of tablespaces within a specific 

database has changed over time and is projected to change in 

the future.

Tablespace Capacity and Utilization Trend Data - Provides 

detailed capacity and utilization trend data for a set of 

tablespaces.

Storage Reports - Stor-

age Array Reports

Array Inventory- Provides basic inventory information and 

storage statistics for SAN storage arrays and NA filers.

Array Capacity & Utilization Overview - Provides summary 

capacity & utilization statistics for SAN storage arrays and NA 

filers, grouped by Customer, Facility or Device Group if desired.

Storage Allocated to Hosts Unmanaged By ASAS - Provides 

summary of storage capacity allocated to unmanaged hosts.

REPORT FOLDER REPORT TITLE
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The SAR PAS reports show OO workflows that have been executed on the OO server 

being mined, and that reference one or more CI types that SAR has data about.

User Permissions
Reports are controlled by the user’s permissions to access the data. If a user does not 

have permissions to view a set of servers, those servers will not display in a report run by 

that user. 

Launching the Reports Feature
To launch the Reports feature, perform one of the following steps:

• From the Navigation pane, select Reports.

• From the View menu, select Reports ➤  Dashboard.

• From the View menu, select Reports ➤  Reports.

• From the Navigation pane, select Scheduled Reports.

Process Automation 

Reports

PAS Run History Summary By Device - Provides device impact 

for PAS workflows sorted by device.

PAS Run History Summary By Flow - Provides device impact 

for PAS workflows sorted by flow.

PAS Run History Details By Device - Provides device impact for 

PAS workflows sorted by device.

PAS Run History Details By Flow - Provides device impact for 

PAS workflows sorted by workflow.

REPORT FOLDER REPORT TITLE
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Reports Display
The Reports feature display consists of a Search pane, a Dashboard, Scheduled Reports, 

report folders, and report parameters.

Figure 3-1: The Reports Feature Display

Search Pane

In the Reports feature, you can use the SAR Client Search feature to find reports by 

defining specific filter criteria. You can save a search as a report definition and create 

custom reports.

Dashboard

The Dashboard provides a display of selected reports. See “Overview of Dashboard” on 

page 49 for more information.
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Report Folders

Reports are organized in the following folders according to regulatory or IT best practice 

standards:

• Compliance History: This folder contains reports about compliance for software 

policies, audit policies, and patch policies by servers, customer, and facility.

• Deployment Life Cycle: This folder contains reports about attributes of servers and 

network devices.

• Storage Reports: This folder contains reports about attributes of storage servers and 

arrays.

• Process Automation Reports: This folder contains process automation reports.

• Custom Reports: This folder contains any custom reports you have created. If no 

custom reports exist, then the Custom Reports folder is not present. For more 

information on creating custom reports, see “SAR Custom Reports” on page 79. 
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• Figure 3-2 illustrates the Report folders in the Navigation pane, including the reports 

you will find in each folder.

Figure 3-2: Report Folders

Report Parameters

Many reports require input parameters in order to be run. For reports that require 

parameters, you can run the report with its default parameter values or modify the 

parameter values. If you want to run a report that includes or excludes certain servers, 

customers, or hardware models, you need to specify this criteria in the report parameters. 

See “Running a Report” on page 66.

Running a Report
To run a report, perform the following steps:

1 From the Navigation pane, select Reports.
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2 Expand the Reports folder and then expand Compliance History. 

3 Select one of the reports listed in the folder.

4 If there are no report parameters in the Content pane, click Run.

5 If there are report parameters in the Content pane, you can either use the default 

parameters or change them:

• To use the default report parameters, click Run to run the report.

• To change the report parameters, see “Modifying Report Parameters” on page 67.

Modifying Report Parameters

You can modify the default parameters of a report. If you modify the parameters of a 

report, your changes become your default settings for that report. To modify the default 

parameters and run a report that includes certain servers, customers, hardware models, 

and so on, perform the following steps:

1 (Optional) Select the date.

2 (Optional) Select the interval.

3 (Optional) You can select Use Relative Dates to set the date and interval as relative to 

when the report is run in the future. See “Setting the Use Relative Dates Parameter” 

on page 68.

4 In the drop-down list for (the Server, Customer, Model, and so on), select one of 

Contains, Equals, Begins With, or Ends With.

5 (Optional) Click the ellipsis (...) button to the right of the [Any Value] fields to open the 

Select Values window.

6 In the Select Values window, select a value in the Available or Selected pane and 

then use the directional buttons to include it in or exclude it from your search criteria.

7 Click OK to save your changes.

8 Click Run to run the report.

If data cannot be found to run the report, “No records to display!” displays.
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Setting the Use Relative Dates Parameter

The Use Relative Dates parameter sets the date and interval as relative to when the report 

is run in the future. Relative dates are calculated in absolute dates offset from the current 

date. For example, you run a report on October 23 of this year, and select the date and 

interval of the report to run from October 21 to October 22. Scheduling this report to run in 

the future without selecting Use Relative Dates will present the results for October 21 to 

October 22 of this year. Selecting Use Relative Dates causes the report to present the 

results of yesterday and the day before yesterday, relative to whenever the report is run.

Report Results
Report results initially appear in a graphical or list view. The graphical report is an 

overview of available data for this report displayed in a pie chart or in a bar graph.
8
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Graphical Report

A graphical report is a bar graph or a pie chart. See Figure 3-3 for an example.

Figure 3-3: Bar Graph
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List Report

A list report is a tabular display of information. Double-click on a row in the list, such as a 

server, audit, or policy, for more detail or to perform an action. See Figure 3-4 for an 

example.

Figure 3-4: List Report

Exporting a Report
You can export a report for use in other applications in your environment and attach a 

report for email distribution. Depending on the report format, you can export a report to 

your local file system as an .html file, a .pdf file, or an .xls file.

To export a report, perform the following steps:

1 From the report, click Export to open the Save window.

2 In the Save in field, enter a location that identifies where you want to save the file to, 

or select from the drop-down list.
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3 Select the file type.

4 Enter a file name.

5 Click Save.

Printing a Report
To print a report, perform the following steps:

1 From the report, click Print to open the Print window.

2 Use the default print options or modify them, and then click OK.

Saving a Search as a Report
Using the SAR search engine you can generate rich SQL queries and save them as BIRT 

reports. In this example, you will use the SAR search engine to look at the SA Server 

configuration items in the enterprise and save the search parameters as a report.

To customize the report definition file you create in this task, see ““Editing a Report 

Definition File” on page 80”.

To perform a search and save that search as a report, perform the following steps:

1 In the SAR Client, in the Search pane, select Advanced Search ➤  New Search.

2 Select the SAS Server configuration item from the Search for Configuration Item 

drop-down list.

3 To find all servers with a reported OS value of either Linux or Windows, perform the 

following steps:

1. Select the Reported OS criteria and Contains from the drop-down lists. 

2. Enter Linux in the next field, and then click the plus (+) button.

3. Select or from the drop-down list.

4. Select Reported OS criteria from the drop-down list.

5. Select Contains criteria from the drop-down list.

6. Enter wind in the next field. 
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4 Click Search to generate the screen illustrated in Figure 3-5.

Figure 3-5: Search Screen

These results are sorted by the first column, Server Name. 

5 Click Result Options to specify a different sort priority. 
2
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The Result Options window shown in Figure 3-6 allows you to select Attributes to 

sort, and to set the order in which each is considered. 

Figure 3-6: Sort Order 

6 In the Attribute Display Name column, select Operating Systems.

7 In the Sorting Order drop-down list, select 1.

8 Click OK. 
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The sorted results of this modified search appear in Figure 3-7 below. Red Hat 

precedes SuSE, which is followed by VMware, then is followed by the Windows 

family of operating systems.

Figure 3-7: Results Sorted by Operating System

You can assign a name to the selection criteria used for this search, and save it as a 

report. At a later date, you could select the report from the SAR Client and run it 

again. You can also save this search as a BIRT report. Doing so will allow you to open 

the report in BIRT to edit its appearance and functionality. 

9 Click Save Search. The “Save or Delete your search” window displays.

10 Save the search with a descriptive name, so that you can run it in the future from the 

SAR Client. In the Search Name field, enter a Search Name, such as SAS_Server_

Search.

11 Select Save as a Report Definition. 

12 Click Save, and then choose a directory to save the SAS_Server_

Search.rptdesign file to.
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Scheduling a Report
You can schedule a report to run at a specified time, and to repeat at intervals. The report 

can be emailed to one or more recipients when it runs.

To schedule a report, perform the following steps:

1 From the report, click Schedule to open the Scheduled Report Options window 

shown in Figure 3-8.

2 In the Schedule Name field, enter the name. The default value is the report type 

name. 

3 Select the frequency, either Once, Daily, Weekly, or Monthly. 

4 (Optional) Select the options available for Daily, Weekly, and Monthly, as appropriate.

5 Set the Start Time.

6 Set the Start Date.

7 (Optional) Select End recurring schedule by, and then set the end date.

8 In the Recipients field, enter one or more email addresses. If you are entering, 

multiple addresses, the addresses can be separated by a space, comma, semicolon, 

or a Return.

9 Select a format for the report output.
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10 Click OK.

Figure 3-8: Scheduled Report Options

Setting Scheduled Report Options

For scheduled reports an Administrator can set the following options:

• Maximum number of scheduled reports each user can enable

• Number of scheduled reports concurrently processed by server

The “Maximum number of scheduled reports each user can enable” option allows an user 

only to enable the number of reports as set by the administrator. This option does not 

prevent the user from creating an unlimited number of scheduled reports.
6
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An administrator can lower the number of scheduled reports to below the number of 

scheduled reports a user currently has configured. The next time the user updates or 

creates a scheduled report, the user will need to disable some of their scheduled reports 

down to the current maximum number of scheduled reports. This option also will not allow 

the user to save changes to a scheduled report if they have already matched the 

maximum number of scheduled reports.

The “Number of scheduled reports concurrently processed by server” option enables an 

Administrator to monitor that the server that processes scheduled reports are running 

smoothly. This setting is designed to keep the server from crashing due to an excessive 

number of reports being scheduled at the same time.

In the event that there are more scheduled reports scheduled to run at a specific time 

than specified in this value, then the server will process the scheduled reports in batches 

of the size specified in this value. Therefore, sometimes reports may not run at the time as 

specified by the user. Running some reports may be delayed due to server load.

To set the options for scheduled reports, perform the following steps:

1 In the SAR Client, from the Navigation pane, select Opsware Administration ➤  

Scheduled Report Options. The Scheduled Report Options options appears in the 

Content pane. 

2 Enter the value for the maximum number of scheduled reports each user can enable 

option.

3 Enter the value for the number of scheduled reports concurrently processed by 

server.

4 Click Save to save the Scheduled Report options.
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Chapter 4: SAR Custom Reports 

Introduction
The Business Services Automation family of products is comprised of a cluster of Oracle 

databases, typically running on a Sun Microsystems server. These databases are 

continuously refreshed and updated by agents residing on the managed servers and 

workstations in the network. 

Server Automation enables you to create and design reports and integrate them into the 

SA Client and the SAR Client. 

This chapter presents how to use content selected from these databases and create 

custom reports. It explains how to create a simple SQL query, how to design a report, and 

how to integrate it into the SAR user interface. 

The recommended authoring environment for custom SAR reports includes the following 

items:

• A file transfer tool

• An SQL query tool 

I N  T H I S  C H A P T E R

This section discusses the following information:

• Introduction

• Designing a Report

• Editing a Report Definition File

• Inserting a Chart

• Integrating a Custom Report into the SAR Client

• Creating SAR Reports

• Parameter Substitution Configuration

• Parameter Substitution of Dates
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• Business Intelligence and Reporting Tools (BIRT) RCP Designer 

(http://www.eclipse.org/birt) BIRT release 2_1_1

• BIRT library file cmdb-data-sources.rptlibrary

• BIRT library file opsw-common-reporting.rptlibrary

• JDBC driver file ojbc14.jar

Designing a Report
Begin your report design by defining its content. To define the report’s content, you should 

determine the report’s purpose, the type of information displayed, and the logical 

grouping of the data set. Then, you can map the content definition into the product-

specific database schema by determining how SAR should represent the data needed, 

the names of the tables where the data is stored, and the names of all of the fields within 

those tables.

Using this information you can write the SQL query that SAR will use to generate the 

report. Writing the correct SQL query is the most difficult part of report creation. The 

standard reports contain a set of queries that are good candidates to borrow work from. 

The report (.rptdesign) files can be found in an installed SAR core at /opt/opsware/

omdb/reports. Whether borrowing from existing reports or creating original content, 

consider using a tool such as PL/SQL Developer to refine and optimize your SQL. 

When you have optimized the SQL, you should test your SQL query to ensure that the 

SQL is valid and returns the expected data. 

When configuring your report library to access your test database as shown in the 

Database URL field of Figure 4-2 on page 82, you must edit the data source in cmdb-

jdbc-reporting in opsw-common-reporting.rptlibrary. 

No AAA-specific considerations need to be made in your SQL. The report engine will 

automatically transform the SQL that you have created at runtime to constrain the report 

results to what the current user can see. 

Editing a Report Definition File
1 In the “SAR Reports” chapter, perform the task “Saving a Search as a Report”. 
0
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2 Start BIRT 2.1.1. In a Windows command prompt, run the command birt.exe.

3 Open the SAS_Server_Search.rptdesign file that you just created. 

As shown in Figure 4-1, the new report contains the form and content of the 

information you selected when defining the report. The header information is already 

in place. 

Figure 4-1: New Report in BIRT

4 In the Outline pane, expand Data Sources, and then double-click the Data Source 

icon. 

5 View the information for the new JDBC Data Source as shown in Figure 4-2.
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6 Click Test Connection to ensure that the report is connected.

Figure 4-2: JDBC Connection 
2
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7 Select the Preview tab, and review the report.

Figure 4-3: Preview Tab
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8 Click on the XML Source tab to see the SQL query that the SAR Client generated.

Figure 4-4: XML Source Tab
4
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9 To group the output by operating system, select the top cell in the header row, right-

click and select Insert Group from the menu as shown in Figure 4-5.

Figure 4-5: Inserting a Group 

In the next window shown in Figure 4-6, you can select the column that provides the 

group identity. 
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10 Select COLUMN_10 to specify the Reported OS column.

Figure 4-6: New Group Creation

11 Click OK.

12 Select the Layout tab.

13 Select the Properties tab. 
6
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14 Select the font properties to make this field smaller and darker.

Figure 4-7: Font Properties
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As shown in Figure 4-8, the report now groups the output by operating system. 

Figure 4-8: Preview of Grouped Report
8
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Inserting a Chart
BIRT can generate a chart to visually display selected elements of the output. Figure 4-9 

displays the detailed SQL query that the SAR Client created. This is the search-Result-

Dataset based on the cust-DataSource data source.

Figure 4-9: SQL Query

To create a new data set based on the same cust-DataSource data source, perform the 

following steps.

1 From the Data menu, select New Data Set.

Figure 4-10: New Data Set
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2 To learn how many instances of each operating system are currently online, in the 

Query pane type the SQL statements Select Count (*) From and Group By. Then, 

drag the desired Available Items from the middle pane to their places in the query 

text. 

The final SQL statement is: 

select CMDB_DATA.SAS_SERVERS.REPORTED_OS, 
count (*) from CMDB_DATA.SAS_SERVERS 
group by CMDB_DATA.SAS_SERVERS.REPORTED_OS

Figure 4-11: Data Set Query

3 Click OK.

4 Drag the Chart icon from the Palette tab to the Layout panel. 
0
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5 From Select Chart Type menu, select Pie Chart.

Figure 4-12: Chart Type
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6 Click Next. A screen similar to Figure 4-13 appears. 

Figure 4-13: New Chart

7 From the Select Data Set option, select Use Data Set, and then select Data SubSet 

from the drop-down list. The Data Preview pane displays the contents of the data set. 

8 Drag the COUNT(*) header to the Slice Size Definition field.

9 Drag the REPORTED_OS header to the Category Definition field.
2



Chapter 4: SAR Custom Reports
10 Click Next. 

Figure 4-14: Report Operating Systems

11 Select the Chart Area line to call up the input fields. You can use these to assign a 

chart title and to define the background.

12 Click Finish. 
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As shown in Figure 4-15, the Layout view displays an icon of the chart, rather than 

the chart itself.

Figure 4-15: Layout View of Chart

13 Drag the chart icon to the top of the report.
4
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14 Pull the handles on the icon to expand it.

Figure 4-16: Chart Icon
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15 Click Preview.

Figure 4-17: Report Preview

Integrating a Custom Report into the SAR Client
To integrate the report into the SAR Client, perform the following steps:

1 Copy the custom report to the /opt/opsware/omdb/reports directory. Repeat 

this step for additional cores as needed; report files are not automatically replicated. 

2 To see this report listed in the SAR Client, add it to custom_def.xml.

Creating the custom_def.xml file

To add a custom report to the SAR Client, you must create the custom_def.xml file 

and then edit the custom_def.xml file to include the report definition of the custom 

report. To create the file, perform the following steps:

1 Open a new file in a text editor.

2 Add the following content to the new text file:

<reporting>
6
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<reports>
<location>/opt/opsware/omdb/reports</location>
<report name="CUSTOMREPORT_FILENAME_EXT">

<display_name>CUSTOMREPORT_DISPLAYNAME</display_name>
<description>CUSTOMREPORT_DESCRIPTION</description>
<parameters>
</parameters>
</report>

</reports>
<folders>

<folder name="custom_reports">
<display_name>Custom Reports</display_name>
<folder_reports>
<report_name>CUSTOMREPORT_FILENAME_EXT</report_name>
</folder_reports>
<subfolders>
</subfolders>
<parent>reports</parent>

</folder>
</folders>

</reporting>

3 Save the file in the /opt/opsware/omdb/deploy/birt.war directory with the 

name custom_def.xml.

4 Set the custom_def.xml file’s user and group ownership to omdb:omdb. If the 

file is not set to these user and group ownerships the SAR Client will not see the file.

Adding a Report to the custom_def.xml File

To edit custom_def.xml to include the report, perform the following steps:

1 Open the custom_def.xml file in the /opt/opsware/omdb/deploy/

birt.war directory. For more information, see “Creating the custom_def.xml file” on 

page 96.

2 Edit the following line:

<report name="CUSTOMREPORT_FILENAME_EXT">

with the file name of the custom report, including the filetype extension.

3 Edit the following line:

<display_name>CUSTOMREPORT_DISPLAYNAME</display_name>

with the title of the custom report as you want displayed in the SAR Client.
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4 Edit the following line:

<description>CUSTOMREPORT_DESCRIPTION</description>

with the description of the custom report as you want displayed in the SAR Client.

5 Edit the following line:

<report_name>CUSTOMREPORT_FILENAME_EXT</report_name>

with the file name of the custom report, including the filetype extension.

6 Restart the SAR Client.

When you restart the SAR Client, you can view and run your new report.

Parameters in Custom Reports

This section presents how to work with parameters in custom reports. A sample 

parameter is as shown:

<parameter>
<name>PARAMETER_NAME</name>
<display_name>PARAMETER_DISPLAY_NAME</display_name>
<datatype>DATATYPE</datatype>
<lookup_sql>SQL</lookup_sql>

</parameter>

PARAMETER_NAME is the name of the parameter.

PARAMETER_DISPLAY_NAME is the name of the parameter to display in the SAR Client. 

For example, “Interval”.

DATATYPE is the type of data that the SQL statement in SQL returns. The DATATYPE 

parameter can be set as one of the following values:

• TEXT - alphanumeric text string

• DATE - a date value

• DATE_RANGE - a date range value

• NUMBER - an integer

SQL is an SQL SELECT statement that returns a single column of data. 

Adding a Parameter to a Custom Report

To add a parameter to a custom report, complete the following steps:
8
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1 Open the custom_def.xml file in the /opt/opsware/omdb/deploy/

birt.war directory. For more information, see “Creating the custom_def.xml file” on 

page 96.

2 Between the

<parameters>

</parameters>

tags, enter the example parameter tag displayed in “Parameters in Custom Reports” 

on page 98.

3 In the line:

<name>PARAMETER_NAME</name>

replace 

PARAMETER_NAME

with the name of the parameter.

4 In the line:

<display_name>CUSTOMREPORT_DISPLAYNAME</display_name>

replace

CUSTOMREPORT_DISPLAYNAME

with the title of the custom report as you want displayed in the SAR Client.

5 In the line:

<description>CUSTOMREPORT_DESCRIPTION</description>

with the description of the custom report as you want displayed in the SAR Client.

6 In the line:

<report_name>CUSTOMREPORT_FILENAME_EXT</report_name>

replace

CUSTOMREPORT_FILENAME_EXT

with the file name of the custom report, including the filetype extension.

7 Restart the SAR Client.

Creating SAR Reports
To create an SAR report, perform the following steps: 

1 Launch BIRT RCP Designer.

2 Select File ➤  New ➤  New Report. The New Report window appears.
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3 Select a directory to save the report into. The directory must contain the following two 

files:

opsw-common-reporting.rptlibrary

cmdb-data-sources.rptlibrary

These two files are located in /opt/opsware/omdb/reports/resources.

4 Type the file name in the File Name field.

5 Click Next.

6 (Optional) Select a report template.

7 Click Finish.

8 Click the Library Explorer tab.

9 Expand the opsw-common-reporting.rptlibrary item.

10 Select cmdb-jdbc-reporting.

11 Drag cmdb-jdbc-reporting to the Outline pane, onto the Data Sources folder 

icon.

12 Click the Data Explorer tab,

13 Right-click Data Source ➤  cmdb-jdbc-reporting. The Edit Data Source window 

appears.

14 View the data connection in the Edit Data Source window shown in Figure 4-18.
0
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15 To test the data connection, click Test Connection.

Figure 4-18: Edit Data Source
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16 Create and name a new data set as shown in Figure 4-19 and Figure 4-20.

Figure 4-19: New Data Set 

Figure 4-20: Name New Data Set 

17 Click Next.
2
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18 Create the SQL query. Drag and drop the selected data rows into the SQL panel on 

the right, remembering to add SQL commands, commas, and spaces, as needed.

Figure 4-21: Creating SQL Query 

19 Click Preview Results to see if the SQL parses and runs.

Figure 4-22: Preview Results 

20 Drag the Table icon from the Palette to the middle row of the layout grid. 
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21 When the Insert Table window appears, set the number of columns to three.

22 Drag the desired fields from the Outline tab on the left into position on the table. 

Figure 4-23: BIRT RCP Designer

23 Select the Preview tab to preview your report.

Figure 4-24: Show Report Parameters
4
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24 Integrate the new report into the SAR Client. The procedure is described in 

“Integrating a Custom Report into the SAR Client” on page 96. 

Parameter Substitution Configuration
Parameter substitution can be configured in one of two ways:

• Using the opsw-common-reporting Report Library

• Using the com.opsware.reporting.util package

Using the opsw-common-reporting report library is recommended.

Using the opsw-common-reporting Report Library

To enable parameter substitution in a custom report using the opsw-common-reporting 

report library, perform the following steps:

1 From the opsw-common-reporting Report Library, add the Report items ➤  

Grid - Report Header to the report.

2 Add the following short script to the beforeOpen script:

queryText = prepareSql(queryText);

Using the com.opsware.reporting.util Package

Report parameter substitution is not supported in local previews using the 

com.opsware.reporting.util package. To test this feature, you must deploy it to 

the SAR server.

For SAR, a com.opsware.reporting.util package was created to use with BIRT. 

Reports are JDBC-based and include embedded SQL. In the data-set of the BIRT Reports 

for SAR, set the beforeOpen script to:

importPackage(Packages.com.opsware.reporting.util)
request = reportContext.getHttpServletRequest();
var requestParamMap = new Packages.java.util.HashMap();
for (i = 1 ; i <  ${Number of Parameters  + 1} ; i++)

{
requestParamMap.put("PARAM" + 
i,reportContext.getParameterValue("PARAM" + i));
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requestParamMap.put("PARAM" + i + 
"CO",reportContext.getParameterValue("PARAM" + i + "CO"));
requestParamMap.put("PARAM" + i + 
"DT",reportContext.getParameterValue("PARAM" + i + "DT"));
}

queryText = SqlUtilities.processBeforeOpenEvent(queryText, 
requestParamMap, request);

This will retrieve the SQL query for the report and pass it to a parser to replace any 

runtime variables. Runtime variables for the SAR reporter are denoted in the SQL as ansi 

style C comments and have a begin and end tag. The begin tag is /*PARAM'n'*/ and the 

end tag is /*/PARAM'n'*/ where 'n' is greater than 0. In addition to the begin and end 

tags, there is a operator position tag /*C*/.

In the above code the token ${Number of Parameters} should be replaced with the 

number of parameters that the report has + 1. For example, if the report has 4 

parameters, replace the token ${Number of Parameters} with the number 5.

For example, the query below for a report with runtime value:

select full_date
from cmdb_data.date_dimension
where 1 = 1
/*PARAM1*/and full_date /*C*/ = trunc(sysdate)/*/PARAM1*/

When the report is run, one of the following events occur:

• If the user selects Any Value for the parameter, then the string between the begin and 

end tags is removed.

• If a value is picked with an operator (in, equal, not equal) then the string between the 

operator position tag and end tag is replaced with the appropriate operator/parameter 

value string.

• If the parameter value is text and case-insensitive (by default), then the left-side 

expression between AND or OR and the operator position tag will be enclosed by an 

UPPER function. The parameter value will also be upper-case.
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Parameters in custom_def.xml for SAR take a string of SQL for their lookup values. 

This is different from the way reports are parameterized in SAS, with a resource type and 

resource field.

Parameter Substitution of Dates
The SAR reporting data source omdb-reporter-ds.xml used by the SAR BIRT engine 

is configured to set all session connections to the current user's time zone as these 

connections are accessed by BIRT. This allows for the use of certain functionality within 

Oracle to ensure that date processing occurs and is displayed relative to the user's time 

zone.

The SAR CMDB-DATA schema includes a DATE_DIMENSION view that is useful in 

creating the date-based SQL typically used in SAR's historical reporting. This view 

contains a number of date-related columns for reporting including FULL_DATE_LOCAL 

and FULL_DATE_UTC. All columns are relative to the user's local midnight boundary 

(including FULL_DATE_LOCAL) except for FULL_DATE_UTC. FULL_DATE_UTC is a 

calculated value based on the offset of the user's time zone from FULL_DATE_LOCAL. 

The time component of FULL_DATE_LOCAL is always midnight (00:00:00), so for 

someone in New York (EST), FULL_DATE_UTC will be 5 hours later than FULL_DATE_

LOCAL meaning its time component will be 05:00:00.

When doing parameter substitution of single dates or date ranges, these values will be 

substituted in the current user's time zone and should always be compared to 

FULL_DATE_LOCAL. When using the resulting DATE_DIMENSION records to access 

historical data tables, the FULL_DATE_UTC column must be used as all SAR data time 

stamps are UTC.

The following two functions are available for performing time zone offsets: 

• UTC_TO_LOCAL: Use this to convert almost all SAR time stamp columns to local time 

for display in the user's local time zone 

• LOCAL_TO_UTC: This will convert a local time stamp to UTC, which may not be useful 

for return to BIRT, but may be useful in other scenarios.

Almost all time stamp columns returned for display in BIRT should be wrapped in the 

UTC_TO_LOCAL function for correct display. The only time you wouldn't do this is if there 

is a need to display the date in UTC or if a BIRT expression is being used to convert the 

UTC time stamp to some other desired value.
107



User’s Guide

10
You can substitute a single date, or the begin date or end date of a date range, into a 

query rather than having to create a full AND or OR conditional statement. To do so, use 

the following syntax:

/*PARAMnVAL*/ sysdate /*/PARAMnVAL*/

/*PARAMnBEGIN*/  sysdate /*/PARAMnBEGIN*/

/*PARAMnEND*/ sysdate /*PARAMnEND*/
8
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